Welcome to WAG Meeting
an AMAC Accessibility Webinar

Basics of
Accessible MS Office Documents
(Word, PowerPoint, and Excel)

Janet Sylvia, WAG Coordinator
May 2, 2018
To Show Closed Captioning

- From Menu: Window>Show Closed Captioning
- Keyboard: CTRL or CMD + F8
Questions

• During presentation type questions in Chat
  • Mouse: click in Chat Box
  • Keyboard: CTRL or CMD+ M
  • Type your message
  • Press Enter on keyboard

• Q/A at end of the presentation
Today’s Presenter

• Janet Sylvia
  • WAG Coordinator and Accessibility Specialist
  • AMAC Accessibility Solutions
Basics of Accessible Word
1) Review Word Documents against New HHS 508 Checklist

• U.S. Department of Health and Human Services (HHS)

• General Office Document File - 508 Checklist
  • Updated for *Revised* Section 508 and WCAG 2.0
2) Readability

- Divide large blocks of text into smaller sections
- Avoid overly complex sentences
- Provide adequate whitespace
- Use line or paragraph spacing (avoid Enter/Return for “blank” space)
- Sans-serif font (Arial, Calibri, Tahoma, Verdana, etc.)
- Font size between 12-18pt
Styles – Normal, Modify
Normal - Modify Style
3) Headings

- Use proper Heading Structure and Hierarchy

- Heading Styles (Heading 1 through Heading 6)
  - Heading 1 for Document Title
  - Heading 2 for *all* Section Titles
  - Heading 3 for *all* Sub-section Titles
  - etc.

- *Modify ALL Heading Styles before first use!*
Heading 1 – Modify Style
(repeat for Headings 2 through 6)
Apply Heading 1 to Document Title
Apply Heading 2 to **all** Section Titles
(Repeat for Heading 3 Sub-section Titles, etc.)
View - Navigation Pane

Title of Document – Heading 1

All Section Titles – Heading 2

All Sub-section Titles – Heading 3

All Sub-sub-section Titles – Heading 4
Additional Styles

- Emphasis (*instead of* Italics)
- Strong (*instead of* Bold)
Title of Document – Heading 1

All Section Titles – Heading 2
Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal.

All Sub-section Titles – Heading 3
Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal.

All Sub-sub-section Titles – Heading 4
Paragraph text is Normal. Paragraph text is Normal.
Emphasis and Strong
4) True Columns and True Lists

• Use Word’s built-in functionality to create:
  • True Columns
  • True Lists
    • Bulleted List (order of list items does not matter)
    • Numbered List (order of list items does matter)

• Avoid
  • Spacebar, tab, enter
  • Only create “visual appearance” of columns and lists, but not accessible structure
Page Layout - Columns
True Bulleted List
- List Item
- List Item
- List Item
- List Item

True Numbered List
1. List Item one
2. List Item two
3. List Item three
4. List Item four
5) Hyperlinks

- **Link text should**
  - make sense when read out of context
  - describe the destination (document name, website)
  - be unique for unique destinations

- **Avoid vague terms**
  - Click here
  - Email me
  - URL text  http://www.ugallo-b59-go2376c.html
Assistive Technologies and Tools - Aggregate Hyperlinks

• Not Accessible – vague and redundant
  • Click Here
  • Assignment
  • Assignment

• Accessible – descriptive and unique
  • Student Disability Resource Center
  • Assignment 1 – Plants and Biology
  • Assignment 2 – Don’t Bug Me
6) Alt Text

- **Text Alternative for Non-text Elements**
  - Image, Chart, Graph, etc.

- **Alt Text**
  - 120 characters or less
  - Conveys function, meaning or purpose of image

- **Long Description (in addition to Alt Text)**
  - Alt text alone insufficient to describe non-text element
  - Provide in surrounding text or link to separate accessible document
Word - Format Picture
Format Picture - Layout & Properties, Alt Text (Description)
7) True Tables

• Use Word’s built-in functionality to create true Tables
  • Design table to read properly: top to bottom and left to right
  • Simple Data Tables only

• General Formatting
  • Provide Title (i.e. Caption) and Summary before the Table
  • Specify Header Row
  • Avoid blank or merged cells
Insert - Table
### Design - Header Row

In the sample Word document, the 'Design' tab is selected. The 'Header Row' option is checked, indicating that the header row of the table will be displayed. A red arrow points to the 'Design' tab and the 'Header Row' check box.

The table in the document is as follows:

<table>
<thead>
<tr>
<th>Header Column 1</th>
<th>Header Col 2</th>
<th>Header Column 3</th>
<th>Header Column 4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Table – Insert Caption

1. Open Microsoft Word and create a new document.
2. Insert a table by clicking on the 'Table' button in the 'Insert' tab of the ribbon.
3. Right-click on the table and select 'Table Options' from the context menu.
4. In the 'Table Options' dialog box, click on 'Insert Caption' to add a caption to your table.
5. Enter your caption text in the 'Caption' field and click on 'OK' to apply the changes.

Please note that this is a general guide and the exact steps may vary depending on the version of Microsoft Word you are using.
Caption – Enter Caption Text

**Caption:**
Table 1: Annual Sales 2017. Table containing 4 columns.
8) Color and Contrast

- Color is not the sole means of conveying important information (i.e. avoid color-coding)

- Sufficient contrast between foreground (text) color and background color

- Background color or design does not overpower text for documents, charts, graphs, tables, etc.

- Use the Colour Contrast Analyser to ensure accessible contrast
## Colour Contrast Analyser

### From The Paciello Group

![Colour Contrast Analyser](image)

<table>
<thead>
<tr>
<th>Text</th>
<th>Large Text</th>
<th>Luminosity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pass (AA)</td>
<td>Pass (AA)</td>
<td>Pass (AA)</td>
</tr>
</tbody>
</table>

- Foreground: #FFFFFF
- Background: #00206B

The contrast ratio is: 13.4:1

- Text passed at Level AA
- Large text passed at Level AA
- Text passed at Level AAA
- Large text passed at Level AAA

### Basics of Accessible Word

![Basics of Accessible Word](image)
9) File Properties in Word

- Metadata describes contents of file (before opening)
  - Title
  - Tags
  - Subject
  - Author
File – Properties, Show All Properties
Word: Title, Tags, Subject, Author
10) Accessibility Checker - Word

- Always use Word’s built-in Accessibility Checker
  - Repair Errors, Warnings and Tips
Accessibility Checker – Repair all Errors, Warnings and Tips

Title of Document – Heading 1

All Section Titles – Heading 2

All Sub-section Titles – Heading 3
Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal. Paragraph text is Normal.

All Sub-sub-section Titles – Heading 4
Paragraph text is Normal. Paragraph text is Normal.
Basics of Accessible PowerPoint
1) Review PowerPoint File against New HHS 508 Checklist

- U.S. Department of Health and Human Services (HHS)
- **General Office Document File - 508 Checklist**
  - Updated for *Revised* Section 508 and WCAG 2.0
2) Slide Design

• Simple Themes

• Solid Colors

• Avoid Themes with drop shadows on design, colors or text
Slide Designs - May not be accessible.
Microsoft - Accessible Template Showcase (Check color contrast, etc.)
3) Slide Layout

- Pre-defined Slide Layouts
- Only Slides with Title
- Default bulleted and numbered lists
- Avoid Text Boxes
Home – New Slide (with Title)
4) Readability

- Slide Titles are meaningful and unique
- Sans-serif Font (Arial, Calibri, Tahoma, Verdana, etc.)
- Bold Text
- Maximum 6-8 lines of text per slide
- Tables, Charts and Graphs on own slide
- Avoid Transitions and Animations
5) Color and Contrast

• Color is not the sole means of conveying important information (i.e. avoid *color-coding*)

• Sufficient contrast between foreground (text) color and background color

• Background color or design does not overpower text on slides, charts, graphs, tables, etc.

• Use the *Colour Contrast Analyser* to check accessible contrast
Accessible – Pattern Fill
Double Click Bar – Format Data Series, Fill & Line

Click to add title

Format Data Series

- SERIES OPTIONS
- FILL
  - No fill
  - Solid fill
  - Gradient fill
  - Picture or texture fill
  - Pattern fill
  - Automatic
  - Invert if negative
- BORDER
Fill & Line – Color, Black (background color for Pattern)
Pattern Fill – Select Pattern
(repeat for each bar)
6) Alt Text (PPT)

- **Text Alternative for Non-text Elements**
  - Image, chart, graph, etc.

- **Alt Text**
  - 120 characters or less
  - Conveys function, meaning or purpose of image

- **Long Description (in addition to Alt Text)**
  - Alt text alone insufficient to describe non-text element
  - Provide in surrounding text or link to separate accessible document
PPT: Format Picture

About Tulips
About Tulips
7) True Tables (PPT)

- Use PowerPoint’s built-in functionality to create True Tables
  - Design table to read properly: top to bottom and left to right
  - Simple Data Tables only

- General Formatting
  - Provide Title (i.e. Caption) and Summary before the Table
  - Specify Header Row
  - Avoid blank or merged cells
Click to add title

**Insert Table**

- **Number of columns:** 4
- **Number of rows:** 5

[OK] [Cancel]
Default Color Scheme NOT Accessible
Double Click Table – Expand Table Styles, Select Accessible Color Scheme
Select Table – Design, Header Row (check box)
8) Multimedia

• Audio
  • Text Transcript

• Audio Video
  • Closed Captioned
  • Text Transcript
  • Video Description (unless talking head video)

• Video
  • Video Description (unless talking head video)
9) File Properties in PowerPoint

- Metadata describes contents of file (before opening)
  - Title
  - Tags
  - Subject
  - Author
PPT: Title, Tags, Subject, Author

Inspect Presentation
Before publishing this file, be aware that it contains:
- Document properties and author's name
- Embedded documents
- Content that people with disabilities are unable to read

Version:
There are no previous versions of this file.

Properties:
- Title: PowerPoint ...
- Tags: Add a tag
- Categories: Add a category
- Subject: Specify the subject

Related People:
Manager: Specify the manager
Last Modified By: Specify the last modified by

AMAC ACCESSIBILITY
10) Accessibility Checker - PowerPoint

- *Always* use PowerPoint’s built-in Accessibility Checker
  - Repair Errors, Warnings and Tips
PPT: Accessibility Checker – Repair all Errors, Warnings and Tips

Click to add title

- Missing Alt Text:
  - Content Placeholder 5 (Slide 2)
  - Content Placeholder 5 (Slide 3)
  - Content Placeholder 3 (Slide 4)

- Missing Slide Title
  - Slide 1
  - Slide 3
  - Slide 4

- Blank Table Rows or Columns
  - Content Placeholder 3 - 4 Rows or...
Basics of Accessible Excel
1) Review Excel File against the *New* HHS 508 Checklist

- U.S. Department of Health and Human Services (HHS)
- **General Office Document File - 508 Checklist**
  - Updated for *Revised* Section 508 and WCAG 2.0
2) Readability (Excel)

- Sans Serif Font, minimum 12pt
- Auto-font color (black)
- Sheet Names are Brief and Unique
- Delete Unused Sheets
- Always Save worksheet with cursor in cell A1 of Sheet 1
**File – Save with cursor in cell A1 of Sheet 1**

<table>
<thead>
<tr>
<th>A1</th>
<th>Winter 2018 Student Roster</th>
</tr>
</thead>
<tbody>
<tr>
<td>B2</td>
<td>Last Name</td>
</tr>
<tr>
<td>2</td>
<td>Doe</td>
</tr>
<tr>
<td>3</td>
<td>Smith</td>
</tr>
<tr>
<td>4</td>
<td>Tanner</td>
</tr>
<tr>
<td>5</td>
<td>Zed</td>
</tr>
</tbody>
</table>
Sheet Names – Right click, Rename or Delete

<table>
<thead>
<tr>
<th>A1: Winter 2018 Student Roster</th>
</tr>
</thead>
<tbody>
<tr>
<td>1: Last Name</td>
</tr>
<tr>
<td>2: Doe</td>
</tr>
<tr>
<td>3: Smith</td>
</tr>
<tr>
<td>4: Tanner</td>
</tr>
<tr>
<td>5: Zed</td>
</tr>
</tbody>
</table>
3) One Item per Sheet

- Place each item (dataset, table, graphic) on its own Sheet
- Divide complex (datasets, tables) into smaller, more manageable units on separate sheets
- Avoid nested datasets and tables
4) Layout

- Title should appear in Cell A1 of the Sheet
- Content begins in cell A2
- Position data along top, left edge of sheet
- Content reads properly from top to bottom and left to right
- Content layout is logical and predictable
<table>
<thead>
<tr>
<th></th>
<th>Last Name</th>
<th>First Name</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Doe</td>
<td>Frank</td>
<td>Junior</td>
</tr>
<tr>
<td>4</td>
<td>Smith</td>
<td>Jane</td>
<td>Sophomore</td>
</tr>
<tr>
<td>5</td>
<td>Tanner</td>
<td>Michael</td>
<td>Senior</td>
</tr>
<tr>
<td>6</td>
<td>Zed</td>
<td>Susan</td>
<td>Senior</td>
</tr>
</tbody>
</table>
5) Row and Column Headers

- Designate Headers for Datasets and Tables
- Avoid merged cells for headers

- Use Define Name for Rows and Columns
  - Datasets:
    - If column and row headers are present, Name = Title
    - If only row headers are present, Name = RowTitle
    - If only column headers are present, Name = ColumnTitle
  - Tables:
    - Select option: My table has Header Rows
<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Winter 2018 Student Roster</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td><strong>Last Name</strong></td>
<td><strong>First Name</strong></td>
</tr>
<tr>
<td>2</td>
<td>Doe</td>
<td>Frank</td>
</tr>
<tr>
<td>3</td>
<td>Smith</td>
<td>Jane</td>
</tr>
<tr>
<td>4</td>
<td>Tanner</td>
<td>Michael</td>
</tr>
<tr>
<td>5</td>
<td>Zed</td>
<td>Susan</td>
</tr>
</tbody>
</table>

To define a name in Excel, right-click in the sheet and select **Define Name...** from the context menu.
### Dataset: Enter Name and Scope

(leave Comment blank)

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Winter 2018 Student Roster</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td><strong>Last Name</strong></td>
<td><strong>First Name</strong></td>
</tr>
<tr>
<td>3</td>
<td>Doe</td>
<td>Frank</td>
</tr>
<tr>
<td>4</td>
<td>Smith</td>
<td>Jane</td>
</tr>
<tr>
<td>5</td>
<td>Tanner</td>
<td>Michael</td>
</tr>
<tr>
<td>6</td>
<td>Zed</td>
<td>Susan</td>
</tr>
</tbody>
</table>

#### New Name Dialog
- **Name:** ColumnTitle
- **Scope:** Roster
- **Comment:**
- **Refers to:** =Roster!$A$2:$C$2

![Excel Roster Sheet with New Name Dialog](image)
### Winter 2018 Grades

<table>
<thead>
<tr>
<th>Last Name</th>
<th>HW 1</th>
<th>HW 2</th>
<th>HW 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Doe, Frank</td>
<td>90</td>
<td>80</td>
<td></td>
</tr>
<tr>
<td>Smith, Jane</td>
<td>80</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>Tanner, Michael</td>
<td>75</td>
<td>95</td>
<td></td>
</tr>
<tr>
<td>Zed, Susan</td>
<td>n/a</td>
<td>90</td>
<td></td>
</tr>
<tr>
<td>Average Score</td>
<td>81.67</td>
<td>85</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Winter 2018 Grades</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Last Name</td>
<td>HW 1</td>
<td>HW 2</td>
</tr>
<tr>
<td>Doe, Frank</td>
<td>90</td>
<td>80</td>
<td>90</td>
</tr>
<tr>
<td>Smith, Jane</td>
<td>80</td>
<td>75</td>
<td>85</td>
</tr>
<tr>
<td>Tanner, Michael</td>
<td>75</td>
<td>95</td>
<td>85</td>
</tr>
<tr>
<td>Zed, Susan</td>
<td>n/a</td>
<td>90</td>
<td>80</td>
</tr>
<tr>
<td>Average Score</td>
<td>81.67</td>
<td>85</td>
<td>85</td>
</tr>
</tbody>
</table>

Format As Table - My table has headers
6) Format Cell Data

- Format cells so all text is visible (i.e. no hashtags ###)
- Avoid merged or split cells
- Avoid text boxes
- Avoid blank rows
- Avoid blank columns
- Avoid blank cells
  - Use other means (i.e. n/a, minus sign, 0, no data, empty cell, etc.)
Avoid Blank Cells – use other means (ex: n/a)

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>C</th>
<th></th>
<th>D</th>
<th></th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Winter 2018 Grades</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Last Name</td>
<td>HW 1</td>
<td>HW 2</td>
<td>HW 3</td>
<td>HW 1</td>
<td>HW 2</td>
<td>HW 3</td>
</tr>
<tr>
<td>3</td>
<td>Doe, Frank</td>
<td>90</td>
<td>80</td>
<td>90</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Smith, Jane</td>
<td>80</td>
<td>75</td>
<td>85</td>
<td>75</td>
<td>85</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Tanner, Michael</td>
<td>75</td>
<td>95</td>
<td>85</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Zed, Susan</td>
<td>n/a</td>
<td></td>
<td>90</td>
<td>80</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Average Score</td>
<td>81.67</td>
<td>85</td>
<td>85</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
7) Alt Text

- Text Alternative for Non-text Elements
  - Image, chart, graph, etc.

- Alt Text
  - 120 characters or less
  - Conveys function, meaning or purpose of image

- Long Description (in addition to Alt Text)
  - Alt text alone insufficient to describe non-text element
  - Provide in surrounding text or link to separate accessible document
Format Chart Area – Size & Properties, Alt Text (Description)
8) Color and Contrast (Excel)

• Color is not the sole means of conveying important information (i.e. avoid color-coding)

• Sufficient contrast between foreground (text) color and background color

• Background color or design does not overpower text on charts, graphs, tables, etc.

• Use the Colour Contrast Analyser to check accessible contrast
Not Accessible – Line Chart contains color-coding
Format Data Series - Fill & Line, Color and Dash Type (repeat for each line)
9) File Properties in Excel

• Metadata describes contents of file (before opening)
  • Title
  • Tags
  • Subject
  • Author
Excel: File – Properties, Show All Properties
10) Accessibility Checker - Excel

- *Always* use Excel’s built-in Accessibility Checker
  - Repair Errors, Warnings and Tips
Excel: File – Check for Issues, Check Accessibility
Excel: Accessibility Checker – Repair all Errors, Warnings and Tips
End of Training

Basics of Accessible
MS Office Documents
• 1) Type questions in Chat
  • Mouse: click in Chat box
  • Keyboard: (CTRL or CMD) M
  • Type your message
  • Press Enter on your keyboard to send message to Main Room

• 2) Ask Questions via Microphone
  • Raise your Hand to be part of the question queue
    – Select Hand icon (above participant names)
    – We will take questions in order received
Contact Information

Janet Sylvia
WAG Coordinator

Join WAG Listserv or Request Training
wag@amac.gatech.edu

Thanks for Joining us Today!